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Mobile Device App Competition
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Presentation: ‘ 2
October 28 - November 2 ¢ Pittsburgh, PA

The competition at the AIChE annual meeting will consist of a poster competition where
finalists will be selected to give a short presentation to a general audience at the
conference in San Francisco, CA on November 3, 2013.
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Instructions:

Before submitting an application or making inquiries, make sure you read the complete le“‘g Ba‘:k'
document on this competition, covering its objectives, rules, judging criteria, and how the
app and poster will be demonstrated at the conference.

Donations small and large and make a
difference, and remember all gifts to the

i AIChE/CACHE APP Complete Documentation AIChE Foundation are tax-deductible.
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The AIChE/CACHE APP competition Committee consists of Chau-Chyun Chen, Scott Donate
Fogler, Robert Hesketh, Jason Keith, Concetta LaMarca.

Questions about this competition can be directed to:

Email: hesketh@rowan.edu Learn more
Robert P. Hesketh
Professor and Chair
Chemical Engineering
Rowan University

201 Mullica Hill Rd.
Glassboro, NJ 08028-1701
Phone: (856) 256-5313

FollowUs in Linkedin k& Twitter = Facebook YouTube = ®® Flickr = (3 Slide Share




Student AIChE/CACHE Mobile
Device APP Competition

e Prizes

— $500 from CACHE for the first place winner of
the best mobile device APP

— $500 from a corporate sponsor for the best
mobile device APP that addresses safety.

 Timeline:
— Intent to submit December 1, 2012

— Preliminary APP and Technical Documentation Submission
February 2013 through website upload (details to be announced)

— Final APP and Technical Documentation Submission 10/1/2013
— Poster Competition — 11/03/2013 San Francisco, CA



APP Competition - Rules

Student teams must consist of fulltime students

Student teams can consist of any discipline, but at least
half of the team must be members of the AIChE

Student developed APPs can be constructed using
existing software templates and components.

The final APP must be an original creation of the team.

Submissions must comply with intellectual property rules
(e.g. copyright etc.)

The student team must have at least one team member
presenting at Annual Meeting.

The App must be able to run on a mobile device that
uses one of these operating Systems: Android,
BlackBerry, iPhone, Palm, Symbian, or Windows Mobile.



APP Competition - Judging
* Creativity and unigueness of the APP
(15%)
» Usefulness of the APP (20%)

» Ease of use of the APP(15%)

* Professional and/or Societal Impact of
APP (20%)
» Poster Presentation which includes

demonstration of APP on a mobile device
at AIChE Annual Meeting (30%)



Submission -1 October 2013

1 month before San Fancisco Meeting
« Description of the APP and equations
* Flow chart illustrating how the APP works

 Sufficient worked-out examples to verifying the
utility of the APP

« Description of broad impacts of chemical
engineering on society

 Sources of technical information
e Sources of software code that were used in APP
« APP Code



What should students do?

Form multidisciplinary teams (CS, EE,
etc.) NOW

Recruit a member that likes to program —
even better has programmed apps in a
previous course

Decide on mobile device (e.g. iphone Is
OS 6 using Objective C; Android’s use
Java.

Download software



Activities to Promote Competition

 AIChE Website
 CACHE Website and Newsletter

 Emalil Sent to Student Chapters

* AIChE Meeting

— 2 Workshops at Student meeting -120
students (42 emails from students so far)

— Brochures at Student Networking Brunch —
500 students

— This session




Need Help with Promoting
Competition
* Need help from faculty to promote
competition (best method)

— Can you talk to your students?

— Tuesday Meeting with Student Chapters
Committee

 AIChE - Michelle S. Marsnick

— Blog for students
— share point site

» Facebook Page on Competition



Characteristics of a Great App

* Why would you want your App on a mobile
device?
* Exploit the mobile device features
— Address book, contacts, and calendar
— Camera and photos
— Audio and video

— Access the internet — get information from
online databases

— Maps and location

— Accelerometer functions for orientation and
motion



Search for similar apps

« Don't reinvent the wheel. Find an Apple sample app that
closely mimics your app. Then strip out the Apple stuff
and integrate your own code into this working sample
shell. (Credit the original App)

« Learn from others' mistakes. Go grab a couple of apps
from the ITunes App Store that are representative of
your competition. Use what they did right, and seriously
avoid what they did wrong.

* Mine the superhighway for clever programming tricks.
When you're stumped (and you will be... several times
or more!), search the Web for a code snippet or
fragment that deftly handles a problem similar to yours.

Building a great app: that’s the objective, see? By Dave Prochnow, PopSci
http://www.popsci.com/diy/article/2009-03/how-make-iphone-app-part-two



http://www.popsci.com/category/popsci-authors/dave-prochnow
http://www.popsci.com/category/popsci-authors/dave-prochnow

Android

Check to see if you have Java Development Kit (JDK)

Download Android Software Development Package
(SDK) Package (follow instructions on website)

Install Eclipse (Integrated Development Environment —
IDE) (Eclipse IDE for Java Developers)

Install Eclipse Plugin
Create simulator

Use Tutorials
— web
— Dummies Guides

Developers



Eclipse - IDE
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Eclipse Plugin

Install the Eclipse Plugin through the Eclipse

— Start Eclipse, then select Help > Install New
Software.
— Click Add, in the top-right corner.

— In the Add Repository dialog that appears,
enter "ADT Plugin” for the Name and the
following URL for the Location: https://dl-
ssl.google.com/android/eclipse/

— Click OK.



Install Android Virtual Device

® 1 71 Create new Android Virtual Device (AVD)

* Create a device using
the Window=>AVD
manager

e Select
— Platform

— SD card size
— Etc.

Marme:
Target:

CPU/SAEI:

50 Card:

Snapshot:

Skin:

Hardware:

CenericAndroidPhone

| Android 4.1.2 - APl Level 16

ARM (armeabi-v7a}

(=) Size: | 1000 | [ mig

(::. File: Browse...
[ | Enabled

(*) Built-in: | Default (WWGABOO)

() Resolution: X

Property Value

Abstracted LCD density 240
Max WM application hea... 48 Delete
Device ram size 512

Owverride the existing AVD with the same name

[ Cancel | [ Create AVD ]




Use Tutorials such as the
Dummies Guide

Copyrighted Material

Making Everything Easier!”

Copyraghte
Making Everything Easier!

Learn to:

« Combine several smaller programs to
create a bigger program

6 - Work with new libraries, closure, paraliel
frameworks, and other new features
« Create basic Java objects and
reuse code

+ Android Jump Start
* Android Background Material « Handle exceptions and events
* The Building Blocks
* Programming Cool Phone Features
* The Job Isn't Done Until... ?arw Burd, 'Ph'D

2 uthor of Beginning Programming
* Alternative Android Development with Java For Dummies

Techniques

Barry Burd

Author of lava For Dummies




IPhone

It Is very useful to have a team member
with an apple computer!

Download latest version of Xcode from the
Mac App Store

Use Tutorials

— Xcode has tutorials — “Hello World”
— Dummies Guides

To load your App to a real phone
Subscribe to the IPhone Developer
Program ($99 + sales tax!)



https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/xcode_quick_start/010-Tutorial_Using_Xcode_to_Write_Hello_World/hello_world_tutorial.html

USIng the iPhone

Application Development

Dummies Guide

* IPhone Application
Development - Step by
Step procedure to create
an App titled Road Trip

« Objective-C
- By Neal Goldstein
» Can a professor who

learned only Fortran
do this?
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Start using Xcode

~ @ Xcode File Edit View Navigate itor Product indow Help o) <) » Wed 1 Robert Hesket =
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006 )
A =, = Loading — | — | T
) (@) | (=) | - - | B @O\ (&)
Run Stop Breakpoints i View Qrganizer
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Choose a template for your new project

L!J ios [ .
[ [E—

l J 27

Framework & Library
| Other 4
{ | Master-Detail OpenGL Game Page-Based Single View
‘ ‘, 0S X ‘ Application Application Application
" Application ‘ - -
! Framework & Library | X'
1 Application Plug-in | 5 | ¥ X
[ System Plug-in [

Other | Tabbed Application Utility Application Empty Application

This template provides a starting point for an application that uses a single view. It provides a
view controller to manage the view, and a storyboard or nib file that contains the view.

1
\
m Single View Application
{
i
|

|D{}] & =

\VLU] File Template Library 4| ()=

[ cCancel | Previous Next

Objective-C class - An Objective-C
class with a header for Cocoa Touch

Objective-C protocol - An Objective-
C protocol for Cocoa Touch

Objective-C test case class - An
Objective-C class containing an OCUnit
test case with a header for Cocoa Touch




Project Options
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Choose options for your new project:
Product Name .RoadT;E 7
Organization Name Flioberrt- Hééketﬁ
Company Identifier [Hesketh ] lo Selection
Bundle Identifier Hesketh.RoadTrip
Class Prefix |RT
Devices | iPhone 3|
@ Use Storyboards
@ Use Automatic Reference Counting
[_] Include Unit Tests
e |D[{} & m
| [Jl] File Template Library ¢ | (83
| Cancel | | Previous | [ Next J " Objective-C class - An Objective-C
== ObIC class with a header for Cocoa Touch
h " Objective-C protocol - An Objective-
mote  C protocol for Cocoa Touch
_~ Objective-C test case class - An
Objective-C class containing an OCUnit
‘et test case with a header for Cocoa Touch




- Work:
G #he Cede The Project Configuration

Debugger -
Breakpoints

Stop Code

Edit View MNavigate Editor Product Window

B RoadTrip.xcodeproj
Xcode ‘

| RoadTrip  iPhone 6.0 Simulator ]
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— DS SO | Summary | Info Build Settings Build Phases Build Rules ¥ Identity
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¥ [ |RoadTrip j, RoadTrip i05 Application Target \ Project Name | RoadTrip

h| RTAppDelegate.h \ . . .
H RTAooDelegate.m Bundle Identifier |Hesketh.RoadTrip Location | Not Applicable

Maiﬂp;‘] bgardh <rorvboard # Roaap o RoadTrip.xcodeproj

gllo REsIony 1.0 Full Path [Users/hesketh/

|—h| RTViewController.h

@ RTViewController.m Devices | iPhone  + | ActiVity Viewer g:;_’;_’:p";ﬂc-“c”ﬂ

» | |Supporting Files
| | Frameworks
| | Products

RoadTrip.xcodeproj [+]

———/// T
Deployment Target | 6.0 ¥ |

¥ Project Document

¥ iPhone [ iPod Deployment Info

Project Format | Xcode 3.2-compatible s |
Main Storyboard 'Maiﬂslowboam Ty | Organization  Robert Hesketh
; T : Class Prefix | RT
Main Interface v |

¥ Text Settings

Flow Control

Indent Using | Spaces ]
Supported Interface Orientations - A
. _ Widths s 4.
Tab Indent
D Iul:l I l:ln [!__P‘I Wrap lines
Portrait Upside Landscape Landscape
Down Left Right | o | {}] &
| [J}] File Template Library NE=E
Status Bar
~ | Objective-C cl - An Objective-C
Style | Default ry jective—C class - An Objective

class with a header for Cocoa Touch

Visibility || Hide during application launch

Objective-C protocol - An Objective-
C protocol for Cocoa Touch

Tinting | Disabled s |

Tint Color I

-~ Objective-C test case class - An
Objective-C class containing an OCUnit

o @ fest  tpst case with a header for Cocoa Touch




Getting Help: Right Click
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Creating a Project: Right Click
for Help

|| @ M

o | A e @'Icude 4.5 Developer Library » )(cude ¥ IDEs » |]_5] Project Navigator Help » — Creating a Project

» [ i05 6.0 Documentation Set
» i 05 X 10.8 Core Library

[ 3 ﬂ‘ Xcode 4.5 Developer Library

Creating a Project

Steps

1. Choose File > New >

2.

New Project.

Select the project
template for your
i0S or OS X product,
and click Next.

Enter the product
name and other
project details, and
click Next.

Specify the project's
location in your file
system, and click
Save.

Start developing a software

T S )

product by creating a project. All | @ Garien 0 = | —
) i s sy
software products require a =8 a-=0 = oo
= e H

project. The project organizes
the files and resources needed to
build one or more products,

such as applications, plug-ins, e

and command-line tools. e

The New Project dialog displays
platforms, template families,
project templates, and a
description for the selected project template. In the project options
pane you enter information required by the template to generate the
project, such as the product name.

Note: The New Project dialog appears in the workspace window
for the workspace to which Xcode will add the project. When you
create a project with no workspace window active, the New Project
dialog is attached to a new workspace window that contains only
the new project.

Prerequisite
¥code Project
¥code Workspace

Ralatard

The project location in your file system and its container in the
workspace window are both derived from your selection in the
project navigator when you initiated the New Project command. That
is, if you have a project selected in the project navigator, Xcode



Run the Code

Stop Code

RoadTrip » iPhone 6.0 Simulator

| = A - . e

v IS RoadTrip

RUN!

Running RoadTrip.app on iPhone 6.0 Simulator

iPhone simulator

£21 1 target, i0S SDK 6.0 ‘.L
3 RoadTrip

> RoadTrip
> Frameworks TARGETS
v Products

AN

No longer red

4
¥ |
Summary Info Build Settings Build Phases Build F;}l
iOS Application Target
Bundle Identifier Hesketh.RoadTrip
Version | 1.0 Build | 1.0
Devices | iPhone : |

o

Deployment Target 0 v
¥ iPhone / iPod Deployment Info
Main Storyboard | MainStoryboard

Main Interface

Supported Interface Orientations

Portrait

)

Landscape
Left

Landscape
Right

iPhone simulator

L

Add Target

+ 0B QDG | - P—
R O‘»C e R3<
Ed NG Y/ p 2

i»

Enting Disabled

Tint Color
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Validate Settings
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IPhone Simulator

® iOS Simulator File Edit Hardware Debug Window Help O % = 4 (= Wed 10:46 AM Robert Hesketh Q =
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Running RoadTrip.app on iPhone 6.0 Simulator
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Add Icon Image
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Xcode Setup
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Xcode Layout with Storyboards
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Story Boards
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Adding Buttons

@ @ | RoadTrip » iPhone 6.0 Simulator ] [E]

Build Succeeded | 10/10/12 at 11:59 AM

Run _ Stop Scheme s 2
||z @ A = » B < » | [RoadTrip » [ |Roa... » B Mai... » B Mai... » FjVie.. » () Vie... ) @ Navigation Item » & Bar Button Item - S
o & RoadTrip

1 target, iOS SDK 6.0
|« Applcon.png
¥ | | RoadTrip Resources
[) BurnRubber.aif
|« Button.png
Button0.png
Buttonl.png
Carlmage.png
CarRunning.aif
Destinationimage.png
NavBarlmage.png
NYCimage.png
|« SeeTheUSA.png
«| SFimage.png
¥ | _|RoadTrip
@ RTAppDelegate.h
@ RTAppDelegate.m

InSte board.s
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Aoard

h| RTViewController.h
@ RTViewController.m
» | |Supporting Files
v | | Frameworks
» &= UIKit.framework
» & Foundation.framework
» &= CoreGraphics.framework
v [ | Products

7&3 RoadTrip.app

+ O@ED®

View Controller - Main Scene

v U View Controller - Main

V[ i View
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All added using drag and drop and filling out labels




Adding Outlets (How to make
the button do something)

@ @ [Road‘l‘rip  iPhone 6.0 Simulator J @ Running RoadTrip on iPhone 6.0 Simulator Iil aii=Mx |
3 > il No Issues & & 1 >

e = - how the Assistant editor* -
y inStoryboard.storyboard (English) » No Selection 42,2/ 0.0

> | mAutomatic ) |:h_| RTViewController.h » No Select

u | < > | [MRoadTrip ) [ |RoadTrip » [E

// RTViewController.h

View Controller - Main Scene
// RoadTrip

v O View Controller - Main

v View Hesketh on 9/26/12.

2 Robert Hesketh. All rights reserved.

// Created by Rober;
// Copyright (c)

[ Image View - SeeTheUSA.png - ] 7
> E Image View - Carlmage.png —
b . Button - Destination 1@ . #import <UIKit/UfKit.h>
b Button - Test Drive sy | T—— £ | @interface RTyYlewController : UIViewController

» | Button - Travel
> Constraints
V¥ @ Navigation Item
@ Bar Button Item - Settings
@ First Responder
Exit

@end

[Z] Navigation Controller Scene

> Q Navigation Controller
‘ First Responder
Exit
Q Relationship “root view controller” t...

Header (*.h) and source files
(*.m) automatically added

®
= n 2 % % |4 |ERoadrip



OUTLET: Car

No Issues

Running RoadTrip on iPhone 6.0 Simulator

> | (£ Automatic )

RTViewController.h » No Selection

View Controller - Main Scene

v 0 View Controller - Main
¥ . View
Image View - SeeTheUSA.png
> ge View - Carlmage.png
» __ Button - Destination
» | Button - Test Drive
» | Button - Travel
> Constraints
v @ Navigation Item
B Bar Button Item - Settings
‘ First Responder

Exit

[Z] Navigation Controller Scene

> e Navigation Controller
‘ First Responder
B exit

Q Relationship “root view controller" t...

(= o = b}
% | v | & RoadTrip

Settings

@interface RTViewController :

// RTViewController.h
// RoadTrip

// Created by Robert Hesketh on 9/26/12.
// Copyright (c) 2012 Robert Hesketh. All rights reserved.

#import <UIKit/UIKit.h>

UIViewController

e

_—

Insert Outlet or Outlet Colle: n

Ctrl Drag from
header file

image to

Then fill out form name

e TTT s

Connection

| Cancel |

Object
Name
Type
Storage

| ca

| UllmageWiew

[ Weak

// RTWiewController.h
/¢ RoadTrip

/¢ Created by Robert Hesketh
/{ Copyright (c) 2012 Robert
#import <UIKit/UIKit.h=

~ @interface RTViewController :

o

@end

on 9/26/12.
Hesketh. ALl rights reserwved.

UIViewController



Showing connections

Ctrl Clicking on View Controller
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Is the internet available?

All Apps must have this (otherwise rejected)

Download Reachability code from Apple Dev.
Website and add to xcode project

Add system Configuration.framework to project

Remove ARC (Automatic Reference Counting)
to Reachability.m in Build Phases dialog with
command: -fno-objc-arc

Add #import <netinet/in.h> to Reachabillity.h
code

Add reachability check code to RTAppDelegate




a Code Added

Turn off wi-fi on computer and run code!!

Y

|
Added . adTrip.xcodeproj — @ RTAppDelegate.m
#Import "ReaChabIIIty-h" ed running RoadTrip on iPhone 6.0 Simulator ‘ E

No Issues
Network Unavailable - It a [ a = B E\ o Lo s | D RoadTrip » | |RoadTrip » |—E| RTAppDelegate.m » No Selection |
p . : Find O RTAppDelegate ’
RoadTrip requires an internet ' // RTAppDelegate.m
connection Style | Textual ::i RoadTrip
Hits must | contain search term /f Created by Robert Hesketh on 9/26/12.
S — [C] Match case // Copyright (c) 2812 Robert Hesketh. ALl rights reserved.

OK

Findin ([ [ RoadTrip
|| And linked frameworks

Found 7 results in 3 files

main.m
> &l RoadTrip project

—| #import "RTAppDelegate.h”
[ ...FromClass([RTAppDelegate class])); - (BOOL)application: {UIApplication =)applic#ion didFinishLaunchingWithOptions:

Ty

gimport “"RTAppDelegate.h" Added COde

import "Reachability.h"

@implementation RTAppDelegate

: RTAppDelegate.h {NSDictionary =) launchOptions
% El RoadTrip project 1 . . . . . .
S/ Override point for customization after application launch. |
— | /{ RTAppDelegate.h NetworkStatus networkStatus =
[7] .. RTAppDelegate : UlResponder <U... [[Reachability reachabilityForInternetConnection] :
_RTA = currentReachabilityStatus];
- |_E| ppDelegate.m it {networkStatus == MNotReachable) {

RoadTrip project UIAlertView #alert = [[UIAlertView alloc]

initWithTitle:@"Network Unavailable"
#import "RTAppDelegate.h” message:@"RoadTrip requires an internet connection'|
= delegate:nil
cancelButtonTitle:@"0OK"
otherButtonTitles:nil];

|:I @implementation RTAppDelegate

[alert show];

}
return YES;
}

- (void)applicationWillResignActive: {UIApplication =)application

[/ Sent when the application is about to mowve from active to inactive state. This
can occur for certain types of temporary interruptions (such as an incoming
phone call or SMS message) or when the user quits the application and it
beains the transition teo the backaround state.



Yellow Titles

[ N Faded Yellow
Road Trip title s —
when error Rosd Trp: S
message
appears

RoadTrip requires an internet
connection

* Yellow with no
error message




Yellow Titles

Added to didFinishLaunchingWithOptions in RTAppDelegate.m

[[UIApplication sharedApplication] setStatusBarStyle:UIStatusBarStyleBlackOpaque animated:NOJ;
UINavigationController *navigationController = (UINavigationController *)
self.window.rootViewController;
navigationController.navigationBar.barStyle = UlBarStyleBlack;
[navigationController.navigationBar
setTitleTextAttributes:
[NSDictionary dictionaryWithObiject: [UIColor yellowColor]

forKey:UITextAttribute TextColor]];

[navigationController.navigationBar setBackgroundimage:[Ullmage
imageNamed:@"NavBarlmage.png"]

forBarMetrics:UlIBarMetricsDefault];
[[UIButton appearance] setTitleColor:[UIColor greenColor] forState:UIControlStateNormal];
[[UIBarButtonltem appearanceWhenContainedIn:[UINavigationBar class], nil]
setTitleTextAttributes:[NSDictionary dictionaryWithObject:[UIColor yellowColor]
forKey:UITextAttributeTextColor]
forState:UlControlStateNormal];
[[UIButton appearanceWhenContainedIn:
[UlAlertView class], nil] setTitleColor: [UIColor whiteColor] forState:UlControlStateNormal;



And It continues



Now after testing on simulator

* To load your App to a real phone
Subscribe to the iIPhone Developer
Program ($99 + sales tax!)

* ODbtain a certificate: See this youtube 10S
Development: Certificate Signing
Request
http://www.youtube.com/watch?v=HIRI30F
6-EK

* Provisioning profile.



http://www.youtube.com/watch?v=HlRI30F6-Ek
http://www.youtube.com/watch?v=HlRI30F6-Ek
http://www.youtube.com/watch?v=HlRI30F6-Ek
http://www.youtube.com/watch?v=HlRI30F6-Ek
http://www.youtube.com/watch?v=HlRI30F6-Ek

Summary

Encourage Students to Start
Working on their APP today

v Form a multidisciplinary team —
recruit both ChE’s and ECE’s
and CS’s

v Decide on operating system and
download appropriate
v  Software

Brainstorm ldeas and search
v whatis similar

Start writing by creating an
outline and then programming




Test Device on IPhone

V¥ To get a device ID using iTunes

. Launch iTunes.

. Connect your device to your Mac.

1
2
3. In the Devices section, select the device.
4

. In the Summary pane, click the Serial Number label under S¢

In iTunes click on serial
number and it changes to
Identifier.

The label Serial Number changes to Identifier and displays t

£ movies iPhone

Identifier (UDID): f8d27ab99b7c7bccSdededb0451ce60228e67 110
Phone Number: n/a a

Command-C fo copy

5. To copy the device ID, position the pointer over the device ID and press Command-C.



Student AIChE/CACHE Mobile
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+ CACHE
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&0 [

THE MULTIMEDIA EDUCATION LABORATORY

MEL is the Multimedia Educational Laboratory in the Chemical Engineering department, University
of Michigan. We create computer based modules for the advancement of Chemical Engineering
understanding. These modules include:

The Visual Encyclopedia of Chemical Engineering Equipment

ChE EQUIPMENT i
- fml‘ l CHEMICAL ENGINEERING EQUIPMENT: Main Menu
M&E BALANCES
HEAT
TRANSFER
BIO SYSTEMS TRANSPORT REACTORS
AND STORAGE

SOFTWARE Welcome to the Encyclopedia FLOWMETERS
of Chemical Engineenng Equipment!
PROCESS
. PEOPLE PARAMETERS Mouse over each category for a more POLYMER ‘
i i f ' industry and -
detailed description of its content PROCESSING g oy o
CONTACT INFO MATERIALS
HANDLING SEPARATIONS:
SEPARATIONS: CHEMICAL
Last Updated MECHANICAL m
Jun 14, 2010. ﬂ
Quit
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